
APPLESHARE SERVER 3.0 ADMINISTRATOR'S QUICKSTART

Before You Start

This QuickStart is designed to help you get AppleShare Server 3.0 file and print servers 
ready and running in the shortest possible time. The QuickStart is divided into three 
sections:

- Getting Started

- Setting Up File Service

- Setting Up Print Service

You may not need to read all three sections -- only those that apply to your specific 
needs. For instance, if you know you will be setting up only a print server, you can skip 
to the section "Setting Up Print Service" after reading "Getting Started."

Getting help

This QuickStart assumes you're already familiar with basic Macintosh concepts and 
tech-niques. However, if you need additional information about AppleShare Server 3.0, you 
have two other sources of information: Balloon Help, which is built into the AppleShare 
Server 3.0 software, and the AppleShare Server 3.0 Administrator's Guide.

Using Balloon Help

If you don't understand the instructions in this guide -- or if you see a window, button, 
menu, or command you want to know more about -- use Balloon Help:

1.  Choose Show Balloons from the Help menu.

2.  Position the pointer over the item you want to know more about.

A balloon appears with an explanation of that item. You can turn off Balloon Help at any 
time by choosing Hide Balloons from the Help menu.

Using the AppleShare Server 3.0 Administrator's Guide

If you still need more information after consulting Balloon Help, see the AppleShare 
Server 3.0 Administrator's Guide. It's easy to locate the information you need: Each 
section of this QuickStart corresponds to a section of the AppleShare Server 3.0 
Administrator's Guide, where all procedures are explained in detail.

Getting started

This section explains how to prepare your Macintosh computer to function as a file or 
print server. The steps presented in this section are explained in detail in Chapter 2, 
"Getting Started," in the AppleShare Server 3.0 Administrator's Guide.

The instructions in this QuickStart assume you have already performed these tasks:

- You have set up the computer.

- You have installed a network card and software, if your network requires it.

- You have connected the server to the network.

- You have activated AppleTalk in the Chooser window and selected the appropriate network 
type in the Network control panel.

If you have not yet performed these tasks, see the documentation that came with either 



your computer or network card, or the manual that came with your network cabling system.

!!  IMPORTANT  The server computer must have at least 4 megabytes of RAM (random-access 
memory) and be running Macintosh system software version 7.0 (or later).  !!

Setting the computer's clock

- Check the computer's clock, and set it if necessary.

The AppleShare file and print servers will use your computer's internal clock for all 
time entries (for logging server use, for instance); to check the clock, choose the Alarm 
Clock desk accessory from the Apple menu. Close the Alarm Clock window when you are 
finished.

Installing the AppleShare Server 3.0 software

1.  Insert the AppleShare File Server disk in the disk drive.

2.  Double-click the disk's icon to open the disk's directory window, if it is not 
already open.

3.  Double-click the Installer icon.

4.  If you plan to maintain both a file and a print server, click the Install button and 
follow the instructions on the screen (then skip to step 7).

Follow the instructions presented on the screen.

5.  If you plan to maintain only the file or the print server, click the Customize 
button.

You see the custom install window:

6.  Select AppleShare Workstation and the server you want to install, and then click 
Install.

You will need to Shift-click to select both options. Follow the instructions presented on 
the screen.

7.  When the installation is complete, click the Restart button.

Setting up file service

This section explains how to set up file service on your server computer. The steps 
presented in this section are explained in detail in Chapter 3, "Setting Up File 
Service," in the AppleShare Server 3.0 Administrator's Guide.

The procedure for setting up file service varies depending on your situation:

- If you are upgrading from AppleShare 2.0, or if you have used System 7 Macintosh file 
sharing on the server computer prior to installing AppleShare 3.0 -- or both -- go 
directly to the next section, "Upgrading to AppleShare Server 3.0."

- If you are not upgrading from AppleShare 2.0, nor have ever used System 7 Macintosh 
file sharing, skip the next section and go to "Using the AppleShare Admin Program."

Upgrading to AppleShare Server 3.0

Follow these steps to upgrade from AppleShare 2.0 or System 7 Macintosh file sharing:



1.  Open the System Folder.

2.  Double-click the AppleShare Admin icon.

In a moment, you see a dialog box:

The number of options presented in the dialog box depends on whether you are upgrading 
from AppleShare 2.0, from System 7 Macintosh file sharing, or from both.

The Users & Groups Data File is a database of users, user passwords, and user groups. If 
you are upgrading, you already have a Users & Groups Data File. However, there can be 
only one valid Users & Groups Data File on your computer's startup disk, so you need to 
indicate whether you want the Admin program to update the existing file or create a new 
one.

Updating the file will let you maintain all the user and group accounts and access 
privileges you set with AppleShare 2.0 or System 7 Macintosh file sharing.

3.  Click the button next to the option you want and then click OK.

You see another dialog box asking you to confirm your choice. The text in the box varies 
depending on what you're upgrading from:

4.  Click OK to complete the update.

Now that you've indicated what to do with your old Users & Groups Data File, go to step 3 
in the next section.

Using the AppleShare Admin program

Follow these steps to start up the AppleShare Admin application program:

1.  Open the System Folder.

2.  Double-click the AppleShare Admin icon.

In a moment, you see a dialog box asking you to name the file server and enter an Admin 
key:

3.  Name the file server.

The name you give the file server is the name users will see in the Chooser when they log 
on to the file server. The file server name can be up to 31 characters long. (It does not 
have to be a ProDOS name, even if Apple II users will be logging on to the file server.)

4.  Enter an Admin key.

The Admin key "unlocks" the AppleShare Admin program. Its purpose is to help prevent 
unauthorized use of the Admin program. The key can be any combination of up to 8 
char-acters. The Admin key records both uppercase and lowercase letters, so be sure to 
type the key exactly as you want it.

!!  IMPORTANT  Remember your Admin key! Record it somewhere if necessary. Replacing a 
forgotten Admin key is difficult and very time consuming. (For instructions on replacing 
the Admin key, see Chapter 8, "Troubleshooting," in the AppleShare Server 3.0 
Administrator's Guide.)  !!

5.  Click OK.



After you click OK, you see another dialog box asking you to confirm the Admin key. This 
is the last time you'll see the Admin key on the screen, so be sure to make a note of it:

6.  Click OK.

In a moment you see a message that you must enter an administrator name and password. 
This means you'll need to set up your own account on the file server.

7.  Click OK.

After a few moments, you see three windows -- the User List and Group List windows, and a 
user information window. For now, you will work only with the user information window. 
Each user account you create will have its own user information window. This one is for 
you as the administrator:

8.  Enter a name in the Name box.

You can enter your own name or use "Administrator."

9.  Enter a password.

You'll use the password to log on to the file server. The password can be any combination 
of up to eight characters. (Uppercase and lowercase letters must match when you log on to 
the server.)

!!  IMPORTANT  Don't use the same password as the Admin key. Keeping the two distinct 
provides an added level of administrator security.  !!

10.  Verify your AppleShare options.

Most of the option boxes -- Login Enabled, Change Password Enabled, and All Privileges 
Enabled -- are already checked. As the server administrator, you'll almost certainly want 
to keep these options enabled. If you're not sure what options you need, accept the 
preset options for now. You can always change options later.

These options are explained in the section "Registering Users" in Chapter 3 of the 
AppleShare Server 3.0 Administrator's Guide.

11.  Click Save.

12.  Close the user information window.

If you are upgrading from AppleShare 2.0 or System 7 Macintosh file sharing, you may be 
able to skip the next few sections:

- If you don't need to add any new users or groups, nor alter the access privileges you 
used with AppleShare 2.0 or System 7 Macintosh file sharing, go to the section "Starting 
Up the AppleShare 3.0 File Server Program."

- If you don't need to add any new users or groups, but you want to change the access 
privileges you originally set with either AppleShare 2.0 or System 7 Macintosh file 
sharing, go directly to the section "Sharing Volumes and Folders."

Registering users

Now that you've named the file server, entered an Admin key, and created an Administrator 
account, you need to register users by assigning each user a personal file server 
account.

1.  Choose Create User from the Users menu.

2.  Enter the user's name.



A name can be up to 31 characters long.

3.  Enter a password.

A password can be up to 8 characters long. Users must enter their passwords exactly as 
you have set them up. (Uppercase and lowercase letters must match.)

4.  Select this user's AppleShare options.

An X should appear in the checkboxes for the options you've selected. To deselect an 
option, click the checkbox so the X does not appear.

Here's a brief summary of how these options function:

- Login Enabled lets the user log on to the file server. You must select this option to 
let the user gain access to the file server.

- Change Password Enabled lets the user change his or her own password.

- All Privileges Enabled gives the user access to all volumes and folders on the server 
computer, regardless of whether you've shared them. Unless you have a specific reason to 
do so, do not select this option.

- Require New Password on Next Login makes the user change his or her password the first 
time he or she logs on to the file server. This feature lets you assign simple pass-words 
while setting up accounts, and then requires users to choose more secure passwords when 
they first log on.

!!  IMPORTANT  Do not use this feature for Apple II or IBM PC users.  !!

- Program Linking Enabled allows a user to create a link between a program on the server 
and a program on his or her computer. Unless you have a specific reason to do so, do not 
select this option.

If other networking services are installed on the server computer, the list of options 
may be longer.

!!  WARNING  Selecting the All Privileges Enabled and Program Linking options pose 
potential security risks. They should be assigned only after you are certain you 
understand their use. See the AppleShare Server 3.0 Administrator's Guide for more 
information.  !!

5.  Click Save to confirm the entries.

6.  Close the user information window.

7.  Repeat steps 1 through 6 for each user you want to register.

Allowing or denying guest access

If you allow guest access, anyone connected to the network can log on to the file server. 
If you deny guest access, only registered users can log on. The program is preset to deny 
guest access; to deny guess access, do nothing -- skip now to the next section, "Setting 
Up and Adding Members to Groups." If you are upgrading from AppleShare 2.0, guest access 
is set to whatever it was before upgrading.

!!  IMPORTANT  If you are not sure whether to allow guest access, do nothing for now. You 
can always change your mind later.  !!

1.  Double-click the <Any User> entry in the User List window.



You see the <Any User> user information window:

2.  Click the Login Enabled checkbox to place an X in it.

Selecting Login Enabled allows guest access.

3.  Click Save.

4.  Close the user information window.

Setting up and adding members to groups

Creating groups allows you to consolidate access privileges for volumes and folders 
avail-able on the file server. Here are two common examples of how to use groups:

- You have 10 users in your office. You want to give them equal access to the two folders 
on the file server. You create one group, make all 10 users members of that group, and 
assign access privileges for both folders to that group. Now all 10 users have access to 
both folders.

- You have 10 users in your office. You want five to have access to Folder A and the 
other five to have access to Folder B. You create two groups -- Group 1 and Group 2. You 
assign access privileges for Folder A to Group 1 and access privileges for Folder B to 
Group 2. Now each user has access to only the folder that his or her group needs.

!!  IMPORTANT  These are two basic scenarios for allowing access to shared folders. There 
are other strategies for allowing access to volumes and folders. For more information, 
see Chapter 3, "Setting Up File Service," in the AppleShare Server 3.0 Administrator's 
Guide.  !!

1.  Choose Create Group from the Groups menu.

2.  Enter a name for the group.

The name can be up to 31 characters long.

3.  Click Save.

You must save the name of the group before you can add users to the group.

4.  In the User List window, select the users you want to assign to this group.

Shift-click to select more than one user.

5.  Drag the users' icons together to the Members box in the group window.

You must drag the icons, not the users' names.

6.  Close the group window.

Sharing volumes and folders

Now that you've registered users and created groups, you need to share volumes on the 
file server. This means you will indicate which hard disks and folders you want to make 
available to users on the file server.

1.  Choose Access Information from the Privileges menu.

The Volumes list in the upper-left portion of the window shows all the hard disks 
connected to the server computer. You need to select either an entire hard disk or 
folders on the hard disk.



2.  Select a volume -- or a folder from within a volume -- from the Volumes list.

To select a hard disk, click its name.

To select a folder on a hard disk, first double-click the hard disk's name, then click 
the name of the folder you want.

!!  IMPORTANT  When you share an entire hard disk, all of the folders contained on it are 
available to users. (Each folder can be protected with access privileges, as discussed 
later in this section.) When you share a folder, only that folder and its contents are 
available to users. You can share multiple folders from any volume, but you must do so 
explicitly by selecting each folder and clicking Share.  !!

3.  Click the Share button to share the volume or folder.

The volume or folder appears in the Shared Items box.

(The Share button changes to an UnShare button each time you share a selected volume or 
folder. Use the UnShare button to remove an item from the Shared Items list.)

4.  If the item you just shared is a folder, set the Same as Enclosing Folder option to 
off.

An X in this box means that the access privileges for Owner, User/Group, and Everyone are 
the same as those of its enclosing folder. If you want different access privileges, turn 
off this option by clicking the checkbox to remove the X.

5.  If necessary, assign an owner to the volume or folder.

The owner of a volume or folder can set or change the access privileges for his or her 
volume or folder. The administrator is the default owner of all volumes and of all 
folders within a volume. You can change ownership if you want, using the following 
procedure:

a..  Select the volume or folder in the Shared Items box.

b..  Select the user or group you're assigning ownership to from the User List or Group 
List window.

c..  Select the icon of that user or group and drag it to the Owner box in the Access 
Information window.

6.  Assign a user or group to the volume or folder.

You need to indicate which user or group will have access privileges for each shared 
item.

a..  Select the user or group you're assigning privileges to.

You can choose one user or one group.

b..  Select the icon of that user or group and drag it to the User/Group box in the 
Access Information window.

7.  Select the access privileges for the volume or folder.

Click the checkboxes next to the Owner and User/Group boxes. An X in a box means the 
privilege is on; an empty box means the privilege is off.

8.  Select the access privileges for guests by clicking the appropriate boxes for 
Everyone.



The access privileges you assign to Everyone apply to users who log on to the file server 
as guests, as well as to registered users. If you denied guest access earlier, skip this 
step.

For more information on guest privileges, see Chapter 6, "File Server Supervision," in 
the AppleShare Server 3.0 Administrator's Guide.

9.  If you want to apply the same access privileges to all the folders within the volume 
or folder you've shared, click the Change All Enclosed Folders checkbox to place an X in 
it.

10.  Click Save.

If you clicked Change All Enclosed Folders in step 9, you see this dialog box:

11.  Click the button representing the choice you want and press OK.

If you are uncertain which option to choose, just click OK. You can change access 
privileges later if you need to.

12.  Repeat steps 2 through 11 for each item you want to share.

13.  Close the Access Information window.

14.  Quit the AppleShare Admin program.

Choose Quit from the File menu.

Starting up the AppleShare 3.0 File Server program

1.  Open the System Folder.

2.  Double-click the AppleShare File Server icon.

You see this dialog box:

Then you see these two windows:

The Volume Info window displays the name of the file server, the zone it's in, and the 
volumes and items you shared and set access privileges for.

The Connected Users window shows the name of any users logged on to the file server (you 
shouldn't have any at this point).

You manipulate the scale in the Remote User Activity box to modify file server 
responsive-ness. (For more information on the Remote User Activity box, see the section 
"Adjusting File Server Performance" in Chapter 6 of the AppleShare Server 3.0 
Administrator's Guide.)

You've successfully set up file service. The users you registered can now log on to the 
file server.

If you have Apple II users who will be using the file server, you may want to allow them 
to start up remotely using a startup program stored on the file server. For more 
information, see Chapter 5, "Apple II Network Startup," in the AppleShare Server 3.0 
Administrator's Guide.

Setting up print service

This section explains how to "capture" a printer, set printer options, and begin using 



print service.

The steps presented in this section are explained more fully in Chapter 4, "Setting Up 
Print Service," in the AppleShare Server 3.0 Administrator's Guide. (More detailed 
informa-tion about the various options for print server administration is provided in 
Chapter 7, "Print Server Supervision.")

1.  Open the System Folder.

To get to the Finder while the file server is running, click the hard disk icon in the 
upper-right corner of the desktop.

2.  Double-click the AppleShare Print Server icon.

In a moment, you see the Setup dialog box:

3.  In the Printer Types box, select the icon for the type of printer you want to 
capture.

"Capturing" a printer means placing a printer under the control of the print server. You 
can capture printers of various types, but only one at a time.

4.  If necessary, select the zone the printer is in.

If your network is not divided into zones, skip this step.

If your network is subdivided into zones, a zone list appears in the upper-right corner 
of the dialog box. Your home zone is automatically selected, and its printers are listed 
in the Available list in the lower left. If you want to select a printer from another 
zone, select the zone, scrolling to find it if necessary. When you select another zone, 
the printers in that zone appear in the Available list.

5.  In the Available list, select the name of the printer you want to capture.

You can capture only one printer at a time.

6.  Click Capture.

You see the Options dialog box:

7.  Select the options you want for this printer.

The preset options are the most common choices for print service:

- The Printing option must be selected for the print server to print documents.

- Selecting the Spooling option means that documents will be stored in the print queue to 
await printing. (To spool a document is to send it to a print server, where it is stored 
in a print queue until the captured printer is free to print the document.)

- Selecting the Bypass option gives users the choice of either sending documents directly 
to the captured printer or to the print server.

The "Seen as" box indicates how this printer will be listed in the Chooser. If you want 
to change the name, enter a new name. (The name can be no longer than 32 characters.)

8.  Click OK.

The Print Server program captures the printer you selected. In a few moments, you see two 
windows -- the Queue and Log windows for the captured printer.

9.  Close the Queue and Log windows.



You won't need to use these windows until after users begin using the print server.

10.  Choose Setup from the File menu.

The Setup dialog box appears again.

11.  Repeat steps 3 through 9 for each additional printer you want to capture.

Repeat the steps until you have captured all the printers you need, or until you have 
reached the maximum of five printers.

12.  Verify that all users have the same printer drivers installed on their computers.

If necessary, update each user's computer with the System 7 installation disks. For more 
information, see the instructional materials that came with your System 7 software.

The AppleShare Print Server is now ready for use, and each captured printer is now listed 
in the Chooser.

Congratulations

You have successfully set up AppleShare 3.0 file and print services. Users can now log on 
to the file server and send documents to the print server.

If you need more detailed information about maintaining the services you've just 
estab-lished, consult the AppleShare Server 3.0 Administrator's Guide


